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1. Entering LearnMate

A. Browsing to the Site

In your web browser, enter the Internet address

you have been given. cf b learnmate.org

B. Logging in
To log in, you require a username and password. Contact your administrator for a username and password if you
do not already have one.

intelitek»»

At the top-right or bottom left corners of the o do ) | T
1 screen, click Log in. = :

Eeana You are not logged in. {Lo%n} I

In the Log in to the site page, enter your Usermname - |jsmith

Password |es..
2 username and password. —
Remember username

3 Click Login. %

A list of available courses is displayed.

1. Entering LearnMate 1
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C. Installing Required Utilities

To prepare your computer for use with LearnMate, you must verify that your computer has the required utilities
installed.

Help Files

: . i Qi . help and support
1 |r7 the Help Files block, click Utilities. The Utilities page is Feedback
displayed. Help Files
Litiliti
dow d the LMAgent setup file

Follow the instructions on the Utilities page to check for, Tt i f A o, i s o s
2 and if necessary install, required utilities. o

1. Entering LearnMate 2
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2. Entering a Course

Viewing and Entering Courses

After logging in, a list of available courses or course categories is displayed.

Mavigation

Home
® My home
b Site pages
b Ny profile
4

Cuurs@

Ll Zoology: Intrndurq%nn to Animals
2 Click the course that you want to enter. 101
Teacher: Jimmy Smith

In the Navigation block, click Courses. A list of
courses that you teach is displayed.

2. Entering a Course 3
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3. The LearnMate Interface

The LearnMate system consists of different types of pages with various clickable options on each page. Shown
below and on the next page, you can see two commonly encountered pages, the Home page and a course home

page:

The Home page lists all available courses.

intelitek»»

Blocks

Navigation .

Available courses
o Engineering Semester 1
o L Engineering Semester

! History 106: The Mayans and
Comments Incas

/ L Archaeology 223

Help Files o) |

L Introduction to Biology 102

help and support
Help Files
Utilities

Teacher: Jimmy Smith

L Zoology: Introduction to
Animals 101

Teacher: Jimmy Smith

L History: The Civil War

Teacher: Jimmy Smith

Home Page

>— Course List

7P §

>

You are not logged in.

Sun Mon Tue Wed

1

8 7 8
13 14 15
20 21 2
27 2 B

2
9
16
23
20

July 2014

Thy

a3

10
17
24

1

fr

1"
18
25

3. The LearnMate Interface
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Course pages show the content and schedule of a course.

Intelltek» Course Page

Home » Courses » Advanced Level Courses » ZOO104 im editing on

Your progress @

T =l Breadcrumbs

o 28 May - 3 June

= My home

b Site pages 4 June - 10 June

b My profile

b Current course “I3 The Girculatory System L
b My courses a

I3 What is a population? Activiti d
vities an

Administration o) | BIOCks - Assignment #1 Resources -
» Course administration / %] vertebrate Anatomy Quiz .
b Switch rale to

b My profile sattings 11 June - 17 June

b Site administration

[ 18 June - 24 June
Comments =l ] 25 June - 1 July

To learn how to navigate LearnMate, see section 4, Navigating in LearnMate. For more information about blocks, see
section 4, LearnMate Blocks. For more information about course activities and resources, see section 12, Content
Authoring. For more information about the other tools of LearnMate, see section 6, LearnMate Tools.

3. The LearnMate Interface 5
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4, Navigating in LearnMate

Navigation between the various pages in LearnMate is designed to be efficient and clear.

Using Breadcrumbs At the top of every LearnMate page you'll find the

breadcrumbs. They show you the path between the Home
page and your current page. Click any of the pages listed in

the breadcrumbs to jump to them.

Clicking Hyperlinks Throughout the system, all dark blue texts are clickable
hyperlinks that take you to another page.

Hyperlinks are found throughout the system, particularly in

“IS Favorite Animal@;wey
the Blocks at the side and in the Course pages.

Using the Navigation Block

Navigation =l |

Home The Navigation block provides access to all your personal

= My home system places, your profile, and your Course pages.

b Site pages Click the ® icons to further expand the list.
b Ny profile

p Currentcourse

b

Courses

4. Navigating in LearnMate 6
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5. LearnMate Blocks

LearnMate 7 provides a wide range of blocks. You and your system administrator decide which blocks are visible on

each page.

A. Adding a Block

To add a block to the Home page or to a course page:

In the Administration block of the Home page or course
page, click Turn editing on.

Select a block from the Add a block dropdown menu at
the bottom of the page.

The block appears in one of the margins of the page. If desired,

move the block by dragging and dropping it with the icon.

Administration

= Course administration

& Turn editing
Editseﬁingsqi_:')
p Users
% Filters

Add a block

Add....

Blog menu

Blog tags
Calendar ke
Comments

Community finder
Course completion status
Coursefsite summary
Courses

HTML

Blog tags

5. LearnMate Blocks
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B. Removing a Block

There are three ways to remove, or at least partially remove, a block from view.

4 Dock the block to the outer margin of the page.

> Hide the content of the block.

> Delete the block altogether using the block actions menu.

=
el

SE
=

ey

This table lists the blocks available in LearnMate.

Block Name Description
Blog Menu Provides links to add a new blog entry.
Blog T Displays a list of blogs where font size visually indicates each blog's use. The more frequently
og Tags
& 196 used blogs appear in a larger font size and least used in smaller fonts.
Calendar Displays a calendar with course events marked.
Displays comments added by all users on the current page, and allows you to add your own
Comments

comments.

Community Finder

Enables you and other users to access public community hubs, and search for courses to
download or enroll in.

Course Completion
Status

Indicates whether a course has been completed or not.

Course/Site Summary

Displays the course or site summary.

Courses

Allows you to quickly navigate between all of your courses.

HTML

Allows you to add text or images on a site or course page. The title bar can be left blank.

Intelitek Grade Reports

Allows you to access the Intelitek Grade Reports, a set of four graphical and statistical reports
for your students’ assignments and quizzes.

5. LearnMate Blocks
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Latest News

Lists the most recent news posted by your site administrators in the News Forum. It also has

a link to the archived news.

Logged in User

Displays your information.

Mentees

Provides mentors with quick access to their mentee(s) profile page(s).

Messages

Lists all new messages received. Provides access to the Messages pages.

My Latest Badges

Displays badges earned.

My Private Ffiles

Enables access to a user's private files area.

Navigation Allows you to navigate throughout the course.

Online Users Lists all course participants who are currently using LearnMate.

People Contains a link to the list of participants associated with the course area in various roles.
Quiz Results Displays quiz results.

Random Glossary
Entry

Displays random entries from a glossary.

Recent Activity

Lists recent changes or additions made to the course.

Recent Blog Entries

Displays recent blog entries.

Remote RSS Feeds

Enables RSS feeds from external websites to be displayed.

Search Forums

Allows you to search course forums for specified text.

Section Links

Allows you and students to quickly navigate to a particular topic/week section of the course

Self Completion

Provides a link for students to declare that they have completed the course. This may be part

of the course completion requirements.

Tags

Displays tags. In the tag block, the size of each tag is related to the amount of items
associated with it. The larger the tag, the more items associated with it.

Upcoming Events

Lists all upcoming events scheduled.

5. LearnMate Blocks
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6. LearnMate Tools

Apart from the Home and course pages, Learnmate includes additional places to help you manage your own

agenda and files as well as your student’s learning progress.

Messages

LearnMate provides you with a simple messaging system.

Access Messages via:

The links in the Messages block

The Navigation block

You can configure the system and define all types of
settings such as (Navigate to Site administration > Plugins
> Message outputs):

P What types of event-based notifications are

Messages = | Navionts received by users
avigation
o) (3% ~ o
Come P Whether or not message notifications are sent to
Mo messages waiting ) . -
Messages « Myhome a user's persongl email account, instant
)} Site pages messaging service, or SMS
w» My profile . .
u View profile The Lea'mMate system also prowde; the option of SMS
 Bermiess messaging between users and mobile phones and the
) Blogs option of system event-based SMS notifications. Your
= Messagqs system must have an SMS provider in order to enable SMS
O L ERESAEE capabilities.
= My badges
Calendar

The calendar keeps track of appointments and events that you
or your administrator has specified.

Access Calendar via:

The Month link in the The Navigation block
Calendar block
Mavigation
Calendar =) |
) (¢ ~ Home
u My home
-« May 2014 [ w Site pages
Sun Mon Tue Wed Thu Fri Sat = Site blogs
1 2 ) )
s 5 8 7 2 9 10 = Site badges
11 12 13 14 15 18 17 = Notes
18 18 20 21 22 23 24 = Tags
25 28 27 28 28 30 31
[ ] Calenq?')r
b My profile

The Calendar displays one month at a time. All scheduled
events are displayed.

Click:

P Anevent to see its details

Tutn:urial{fgIJ

P New event to schedule a new event

g

You can choose which events to show using:

The drop-down menu. The Events Key
Detailed month view:

All courses -
.'h Events key

P Hide global events
D Hide course events
B Hide group events

D Hide user events

6. LearnMate Tools

10
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My Profile

Your LearnMate profile tells other users a little about you. It
also specifies your preferences for how LearnMate should
work.

To:

See your profile as Edit your profile, click Edit
others see it. Click View profile in the
Profile in the Navigation ~ Administration block.

block.
oc = Wy profile settings

= My profile [ Editprz@%
» View profile = Changef_Jssword
Y Fnrum@_n)sts ) Roles

Edit your profile as required, and click Update Profile once
done.

Note that some fields are voluntary, others are
compulsory.

+ General
First name™ IJUhn

Last name™® |Smith

You can also change your password. Do so regularly to
protect your security.

- My profile settings
» Edit profile

s Change |:|::1ssw.'ca£‘ﬁ_rIJ
» Messaging

My Private Files

LearnMate allows you to upload and store your own files. This is
useful for example, for accessing your files from multiple
computers.

Access your private files via the Navigation block.

Mavigation

Home
m My home
p Site pages
w» Ny profile

® View profile
Forum posts
Blogs
Messages

Wy private ﬂlig
My badges

" B R vw

Your Private Files area allows you to add files, download
files (individually or all at once), delete files, and to create
folders to help you organize your files better.

Files
R -
» (& Files

Right-click a file to view information and options.

Edit Career and Technical Education Final.docx [x]

Download | Delete.

6. LearnMate Tools

I
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Blogs The Blog menu block allows you to add blog entries and
view any entries for a course. You can also use the blog
settings (Site administration > Appearance > Blog) to
change whether a blog is visible, or to allow external blogs.

Blog menu =l |

() [ ~]

Each user can maintain a personal blog, which is viewable and
searchable by all users.

Wiew all entries for this course
Wiew my entries about this course
Add an entry about this course

Wiew all of my entries
Add a new entry

Badges The creation and management of badges can be found in

: the course administration block.
Teachers can award badges to students to reward excellence in

learning. w Badges
» Manage badges
» Addanew badge

6. LearnMate Tools 12
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7. Student Enrolment Methods

Note: Students must first be added as users to the system by the administrator before being enrolled into a course.

You can enroll students into your course individually, in bulk, or you can provide students with an enrolment key. An
enrolment key is simply a password that students can use to self-enroll into the course.

Ensure that you enter the course before performing the actions below.

A. Enrolling Students with an Enrolment Key

Course administration
& Turn editing on

Edit settings
In the administration block of a course, navigate to Course - |lzars
administration > Users > Enrolment methods. z_ Enrolled users

p Enrolment methods

M Groups
b Permissions

Choose

2 Inthe Add method dropdown menu, select Self enrolment.  [=E = S iie gy =
Self enrolment
Guest access L

3 On the Self enrolment page, complete the Enrolment key Enrolment key o I-—

field.
4 Complete the other fields as required, and then click Add Add method
method. \b
5 Distribute the enrolment key to your students, either via

email or in person.

7. Student Enrolment Methods 13
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B. Enrolling Students Individually (Manual Enrolment)
Course administration
& Turn editing on
Edit seftings
1 In the administration block of a course, navigate to Course - lsers
administration > Users > Enrolment methods. z'_ Enrolled users
p Enrolment methods
. Groups
b Permissions
In the Add method dropdown menu, select Manual
2 enrolments Manual enrolments
' Self enrolment
Guest access
3 Complete the fields as necessary, and then click Add method. Add method
The Manual enrolments options line is displayed. wb
. . , %) @ &) (A
4 In the Manual enrolments options, in the edit area, click the R o
Enrol users button.
5 On the manual enrolments page, select any users you want to < Add
add to the course, and then click Add. . -

7. Student Enrolment Methods 14
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8. Working with Outcomes

The LearnMate system allows you to create and manage outcomes. Outcomes are also known as Standards.

Note: Outcomes are not part of the default installation.

A. Creating New Outcomes

Create an outcome for your course.

w» My courses

1 Enter the desired course. [ 3 ZDDEHE)
p HIS3

i Reports
[] Grades

In the Administration block, click Outcomes. If this option ¢ DUTEDI’H%
is missing, contact your administrator. p Badges

= Backup
@ Restore

, ) Edit outcomes
3 Near the bottom of the page, click Edit outcomes. @

Add a new outcome
4  C(Click Add a new outcome. ‘b

- ¥ Qutcomes

In the Add a new outcome page, complete the necessary Full name™ I
5 fields, and then click Save changes. The outcome is Short name® Ii
created.

standard outcome [

8. Working with Outcomes 15
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B. Assigning Outcomes to Activities

After creating an outcome, assign it to an activity or quiz.

. . Turn editing on
1 Click Turn editing on. @

Eqit~ |

| B} Edit settings

|;| Move right
In the Edit dropdown menu of an activity or quiz, click |5| Hide
Edit settings. _
! |_'_;| Duplicate

|E| Assign roles

(% | Delete

' b Outcomes
3 Click Outcomes to expand the outcomes area.

- ¥ Qutcomes
In the Outcomes area of the page, check the desired
outcome 1 %L?

outcomes that you want to add to the activity or quiz.

5 Click Save and return to course or Save and display to ve and return to course ve and displa

confirm.

8. Working with Outcomes 16
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Q. Standard Reports

The standard LearnMate reports aid you in keeping track of your students’ progress in your course.

Ensure that you enter the course before performing the actions below.

A. Accessing Reports

w Reports
Logs
Keep track of other student activities using the reports Live logs
area in the Administration block. Activity report

Course participation
£ | Course users

B. Customizing Reports

You can change the settings of some of the reports. You can perform the following actions:

P Change the students that appear in the
report. Choose which logs you want to see:

Change the time period of the report.

Introduction to Competitive Robotics for Cortex

All days All activitie
Get these logs

Educational level
Filter the results by educational level. ‘

Change the activity or quizzes shown.

Change the actions shown.

v v Vv WV

9. Standard Reports 17
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10. Intelitek Grade Reports

The Intelitek Grade Reports provide you with graphical and statistical information about the grades of your students.
There are four different Intelitek Grade Reports, each providing you with different information about course
activities and grades.

A. Accessing Intelitek Grade Reports

To access the Intelitek Grade Reports, enter your course
and then click the link in the Intelitek Grade Reports
block.

Intelitek Grade Reports =

Intelitek Grade Reports
All available Grade Reports will be displayed.

B. Activities Average Report

The Activities Average report shows the average, minimum, and maximum scores for students in each course
activity or quiz.

P Click the title of the report to show or hide  Activities Average:
the report.

P Click the name of an activity or quiz to )
display the average score the students Final Exam {H_w)
attained for that activity or quiz.

Midterm Exam 1 M o-5
M 56-85
86 - 100

P View the graphic on the right for the
statistics of the activity or quiz.

Min:65 Average:83 Max:94

10. Intelitek Grade Reports 18
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C. Single Student Grade

The Single Student Grade Report displays the grades of all course activities and quizzes for each individual student.

P Click the title of the report to show or hide Single Stuydent Grade:
the report. L\fb

Select User: |Amy Swanson ¥
P From the Select User dropdown menu, Abraham Dixon
Amy Swanson
select the student whose grades you want - -
t0 view Catherine Simon
‘ Dewey Baker s

Erik Sims
Ethel Jackson

User Activities Grades midterm exam 2
100 Student Grade: 88
P View the column graph to see the grades i
.
for that student. Roll over a column with % 0 N
your cursor to show the actual grade for <
Lo . 25
that activity or quiz.
0
midterm exam 1 midterm exam 2
Activities

D. Student Activity Matrix

The Student Activity Matrix is a color-coded display of the grades of all individual students for each activity or quiz in
the course.

P Click the title of the report to show or hide  Student Activity Matrix:
the report.

Student midterm exam 1

P Roll over a cell in the matrix to view the Abraham Dixon I
number grade the student attained for Amy Swanson

that activity or quiz. Catherine Simon m

Dewey Baker
Erik Sims

10. Intelitek Grade Reports 19




LearnMate 7 intelitekw

Teacher’s Quick Start Guide

E. Activity Success Chart

The Activity Success Chart displays the percentage distribution of the grades for each course activity or quiz.

P Click the title of the report to show or hide  Activity Success Chart:

the report.
select Activity: | Total Course v |
P Inthe Select Activity dropdown mend, Total Course
select the activity or quiz whose
percentage distribution you want to view. midterm exam 1

midterm exam 2

Percentage Distribution of Grades

Wo-55
P Roll over areas of the distribution pie chart 76-85 56 - 75
. b -
with your cursor to reveal the number of 4 (40%) W76 -85
86 - 100

students whose grades fell within that 40%
range. The image at right shows that 4 .
students (40% of all students) scored

between 76% and 85% on the activity.

10. Intelitek Grade Reports 20




LearnMate 7/ intelitekw

Teacher’s Quick Start Guide

11. Grading Your Students

Use LearnMate to grade your students quickly and effortlessly. Keep track of your students’ grades with ease.

A. Grading Quizzes and Assignments

To grade a quiz or assignment:

» My courses

1 Enter the desired course. b ZOOEHE')
p HIS3

w Course administration
& Turn editing off
i=; Edit settings

Navigate to Administration > Course b Users
2 administration > Grades. The Grader Report is T Filters
displayed. p Repors
|a] Grades
[ Elads{E}
& Backup
In the Grader Report, click the assignment or #] vertebrate anatomy quiz

quiz that you want to grade.

P Ifyou are grading an assignment, continue to section B. Grading Assignments, immediately below. If you are
grading a quiz, continue to section C. Grading Quizzes, below.

11. Grading Your Students 21
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B. Grading Assignments

1 Click View/grade all submissions.

View.r'grade{%l submissions

Grade

2 Click the 1 icon in the row of the assignment that you want to

grade. ET‘

Grade
Revi h i d th h de in the Grad Grade —————————
3 eview tne assignment, and then enter the grade in the Grade Grade out of 100 I?S_

out of 100 field. Complete any other fields as required.

Current grade in -
gradebook

4 (Click Save changes. The assignment is graded. w

11. Grading Your Students 22
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C. Grading Quizzes

-+ Results
P Most quiz questions are graded automatically. o Grades
1 For those that are not, navigate to o Responses
Administration > Quiz administration > Results o Statistics
> Manual grading. o Manual grading
= Locally assi&)d ro
grade
2 P Click grade for the question you want to grade Or
or click grade all to grade all questions.
-;'sd@ll
P Review the question, and then enter the grade M
' ark I
3 in the Mark out of 1.00 field. 79 |outof 1.00

4 P Click Save and go to next page. The question is
graded.

11. Grading Your Students 23
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D. Using the Grader Report

Keep track of all your students’ grades with the grader report.

= My courses

1 P Enter the desired course. 2 EDDHEB
b HIS3

w» Course administration
% Turn editing off
» Activity chooser off
Edit settings

) » Inthe Administration block, click ) Users
Grades. T Filters
p Repors
[+] Grad
} Bad
P The Grader Report is displayed. The Zoology: Introduction to ... [5]
report shows a list of your students, < Vertebrate Anatomy & | [7] vertebrate anatomy quiz & | ' Course total %
3 and their grades for every 72.00 . 78.00

assignment. In addition, the Course
total for each student is displayed.

7a.00 - 78.00
P Use the Grader report dropdown
menu to view and edit Grader report Grader report
settings and options. Explore these
options and see how they can be of
use to you.

4 » Turn editing on to edit individual Tumn editing on
grades in the Grade Report. \b
5 P Click Update to confirm the changes. %}

11. Grading Your Students 24
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12. Content Authoring

LearnMate allows you to author content and create your own courses with your own educational material. On
individual course pages, you can add content and edit it, insert review items such as quizzes, and order and fit your
content to make it look just how you want it to.

The course pages are where all activities and resources for the student are listed. When adding activities and
resources, try to do so in the order in which you want your students to access them. The activities and resources
may be divided by Week or by Topic. Once you add an activity or resource, you can still move that activity or
resource up or down the page and between topics.

Ensure that you enter the course before performing the actions below.

A. Adding Activities and Resources

Follow this procedure to add activities or resources to your course.

Administration

1 In the Administration block of the Home page or = Course administration
course page, click Turn editing on. & Turn editing q%
é23 Edit settings
p Users
F Filters

Click Add an activity or resource. Note that you
2 canadd the activity or resource at any point
during the course.

+ Add an activity or resource

3 Select the activity or resource that you want to '%b 84 Assignment
add.
=¢ Chat
4 Follow the resource/activity - specific instructions on the subsequent page to complete the addition of the

activity or resource.

12. Content Authoring 25
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The activity or resource is displayed. Where required, Edit™ |Z|
update, hide, or perform other actions. Keep editing -

turned on to do so. s |£‘| Edit settings

(%] Move rignt
(@] Hide

! |;| Duplicate
|E|Assign roles

|;| Delete

B. Using the Edit Commands

This table summarizes all of the edit commands that you can apply when editing is turned on.

In the Edit Settings Menu On the Course Page
| /| Edit the settings |88%|  Edit the settings
| = | Move the activity/resource to the right (indent) |4*D| Move the activity/resource

and  Hide/show the activity/resource Toggle the grouping options

| N | Duplicate the activity/resource |@| Manual Completion Indicator
| A | Assign roles to the activity/resource IEI Edit the title
@
=S Highligh i highlight (i i
| A | Delete the activity/resource or ighlight topic or remove highlight (in topic

format only)

&
or Hide or show topic
=
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C. Activity and Resource Types

This table lists and describes common activity and resource types.

Activity Type Description
Assignment Requires students to complete a project, such as work on an essay, a report, or a model. All
digital files can be submitted via LearnMate.
=l
Certificate A certificate is generated upon completion of a course when the criteria are met.
Chat Allows you to have real-time synchronous discussions with your students and fellow teachers
via the web.
. |
Choice Requires students to answer a single question that you pose.
4
N
Database Requires that students submit specified information in separate, defined fields, into a shared
database. A student's contribution may be graded, and depending on the preferences that
L , - . -
r you set, students may see each other's submissions. Students may also be given permission
—_—

to search the database, and they may also be able to comment on other students’
submissions. Some of the many things you can use the database to do include:

P Showcase student projects
» Pool resources such as citations, abstracts, and documents
P Log class events and topics

P Create a suggestion box for student feedback

External Tool

e
[

Enables students to interact with educational resources and activities on other websites.

Forum

Acts as an online notice board to which students and teachers can post messages and post
comments to messages posted by others.
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Glossary This is a list of definitions that students help create.
L
Lesson Allows you to deliver content and/or practice activities in interesting and flexible ways. A
lesson can includes a variety of review question types as well.
il
Questionnaire Requires that students complete questionnaires to provide user date for surveys.
xll‘
LA
Quiz Tests student's knowledge of the content covered in the previous lesson, or the entire
course.
2
L
| S—]
SCORM package SCORM packages provide online, interactive lessons that student’s study in their own time.
(2]
Survey Requires that students answer a set of questions that you pose. These are not graded.
“lo
Wiki An online document that students write together collaboratively.
W
Workshop A hub for the collection, review, and peer assessment of student work
—_——
>~
Resource Type Description
Book Create a multi-page resource in a book-like format with chapters and subchapters.
I
-
File Provides students with a file that they can download.
L
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Folder Provides access to a number of files students can download.

e

IMS content The IMS content package makes it possible to store chunks of material in a standard format
package which can be re-used in different systems without having to convert the material into new

formats. This resource enables such content packages to be uploaded as a zip file and

&l added to the course.

Label Add text or multimedia to the course page to improve the appearance of the course and
better organize the course page itself.

@

Page Create a web page for your students.

[

URL Provides a web link as a course resource.
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13. Managing Course Settings and Content

A. Adjusting Course Settings

Change the course settings in order to make them just right for you.

P To edit the course settings, click Edit settings in - Course administration

the Administration block. % Turn editing off
»  Activity chooser off

g0y Edit settin

b Users 35
T Filters

b Repors

Change important settings such as:
» The course start date
P The overall appearance
P Ability of guests to access the course
4

The maximum size of a file that can be uploaded
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B. Assembling and Combining Course Content

You can combine course content by importing activities and quizzes from one course to another.

=, Backup
o | Restore
In the administration block of the course that you want to g
1T : . ¥y Impport
import into, click Import. <R

p Question bank

@ HIS305 History: The Civil War

, Select the'course from which you want to import content. | m

Click Continue.

, , 1. Course selection » 2. Initial settings »

3 Follow the steps of the import process, selecting the - Backup settings

course material that you want to transfer. Include activities
4 Click Perform import. The course content is now in the Perform import

target course.
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C. Backing Up and Restoring Content

your computer. Later, you can re-upload the zip and restore a course.

Keep your course content backed up. This process creates a Zip file of your entire course that you can download to

Backup course materials using the Course administration >
Backup option in the administration block.

Restore backed-up content with the Restore option.

Administration

=) |

w Course administration
& Turn editing on
o3 Edit settings
b Users
5 Filters
b Repors
|a] Grades
) Badges
@, Backup
= Resl’iﬁl

Administration

w Course administration

S Turn editing on
¢23 Edit settings
p Users
5 Filters
b Reports
[a] Grades
)} Badges
{5} Backup
| Restope
& Impo%[_")
<7 Reset
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D. Adjusting Course Completion Settings

Note: Course completion settings are not part of the default installation.

You can adjust the completion settings of a course. This controls the items that students have to fulfill in order to
successfully complete the course. Your administrator must first enable this feature before you change the course
completion settings.

1

Enter the desired course and, in the Administration block navigate to
Course administration > Edit settings.

In the Edit course settings page, click Completion tracking to expand
the completion tracking area.

In the Enable completion dropdown menu, select Yes.

Click Save changes.

In the Administration block, navigate to Course administration >
Course completion.

The Edit course completion settings page is displayed.

Edit any course completion settings as desired, and then click Save
changes to confirm.

On the course home page, click Turn editing on.

Add the Course completion status block. This block helps you and
your students manage items that need to be completed.

w Course administration
S Turn editing off

Edit settings
p Users si")
5 Filters

p Reports

|2] Grades

4 Gumpleti@? tracking

w Completion tracking
Enable completion

T

w Course administration
& Tumn editing off
= Activity chooser off
Editsettings
Course completion
b Users @')
T Filters
) Reports
|a] Grades

T
BT

Turn editing on

Add a block

Course completion status
Course/site summRy
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14. Questions and Quizzes

Assessing students through tests and quizzes is a common task for teachers. Prepare questions and quizzes easily

using the LearnMate system.

Ensure that you enter the course before performing the actions below.

A. Adding Questions to the Question Bank

Add new guestions into the question bank. You can access those questions at a later time. To create a new

guestion:

In the Administration block, navigate to Course
administration > Question bank > Questions.

2 Click Create a new question.

3 Select the desired question type, and then click Next.

On the subsequent page, complete the compulsory
4 fields, filling in the voluntary fields as necessary. Then
click Save changes.

Your question is now in the question bank.

w (luestion bank
m Questigns
m Categ 5
m |mport
m Export

reate a new questina..

Choose a question type to add

=% Calculated

The answer

%% Calculated multichoice anumber o

: guestion mi
*% Calculated simple selectad fro
== Embedded answers (Cloze) possibilities
D Ezsay

@ 323 Matching

= Multiple choice
25 Numerical

@ 272 Random short-answer
matching

— Shor answer
*+* True/False

&l Description

g

% ancel
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B. Assembling a Quiz with Questions from the Question Bank

You can pick and choose questions from the question bank and add them to quizzes.

1

Create a quiz using the Add an activity or resource option.

Click the quiz link in the course home page.

Complete the appropriate fields and click Save and Display.

Click Edit quiz. (If you are returning to a quiz where you have
already added questions, click Edit quiz in the Administration
block.)

Click show to display the question bank.

Select the desired question(s) to add to the quiz. Then click Add
to quiz.

Your question bank question(s) is now in the quiz.

+ Add an activity gf resource

i@ _ﬂ/}uuiz

ave and display,

Question bank contents [Show]

{¢ [¥] 8= Match
With selectet

« Add to quiz
Y= - [ ]
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C. Setting Start and End Dates for Your Quiz

You can choose the timeframe within which students can attempt quizzes, view quiz results, and obtain feedback.

Administration =l
1 In the Course administration submenu of the w Course administration
Administration block, click Turn editing on. % Turn editing on
ésy Edits as
b Users
Eqit~ (&)
! P8 Edit settings I
) ) (% | Move right
In the Edit menu for the quiz that you want to edit -
2 and/or update, select Edit settings. |§| Hide
The Updating Quiz page is displayed. ([ Duplicate

|I|Assign roles

|E| Delete
b Timing
3 Click Timing to expand the timing options.
b Gra
Set the timing options as desired.  Timing
; Open the quiz @ [ X B B E @ Enake
4  You must check the Enable box of the Close the quiz Close the ouiz [N TR FETIE 2N KN 0 @, croo
settings in order to allow students to receive post-quiz Time limit @ |5 [T O Enable b
feedback.

Click Review options to expand the quiz's feedback

b Revir‘ﬁjw options @

> and review settings options. b Display
Later, while the quiz is still
‘ ‘ , open

Change the review options as desired.
6 , , , , # The attempt

The review options determine when students receive

feedback and what kind of feedback they receive. w Whether correct

W Marks

7 Click Save and return to course to confirm the ve and return to course;
changes. ‘b
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